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Kapitel 3 – Verwendete Hardware

3. Verwendete Hardware

Bei  der  Erstellung  der  Bachelorarbeit  ist  die  nachfolgend  beschriebene  Hardware  verwendet 
worden.  Dabei  wurde  das  TI C2000 Peripheral  Explorer  Kit  gekauft,  das  Headerboard  für  den 
HILEVEL Tester selbst erstellt (Schaltplan und Layout) und der Praktikumsversuch „Nachregelung 
(Linearachse)“  aus  dem  Regelungstechnik  Labor  der  FH  Rosenheim  im  Studiengang 
Produktionstechnik verwendet.

3.1. TI C2000 Peripheral Explorer Kit

Das  Board  des  TI  C2000  Peripheral  Explorer  Kit  [6]  enthält  Peripherie  z.B.  LEDs, 
Drehpotentiometer, Temperatur Sensor, Anschlüsse für Audio-In und Headphone-Out und viel mehr 
für  einen  schnellen  Einstieg  in  die  Programmierung  eines  C2000  Mikrocontroller  und  zum 
Experimentieren.  Über  den  100-pin  DIMM1 Sockel  können  verschiedene  controlCARDs 
eingesteckt  werden.  Die  verwendete  controlCARD  [7]  enthält  den  C2000  TMS320F28335 
Mikrocontroller [8].

In der Abbildung 2 ist das verwendete Peripheral Explorer Kit Board mit der eingesteckten 
controlCARD zu sehen. 

1 DIMM: Dual In-Line Memory Module 

3

Abbildung 1: Peripheral Explorer Kit mit der controlCARD
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Die  Abbildung  3  stellt  das  Peripheral  Explorer  Kit  Board  dar  und  beschreibt  die  verfügbare 
Peripherie. Für die ersten Tests der Toolchain wurde einer der beiden Potentiometer, die ADC2 Pins 
und  die  PWM3 Pins  verwendet.  Die  genaue  Umsetzung  und  Verwendung  wird  im  Kapitel  5 
beschrieben.

2 ADC: Analog-to-Digital Converter
3 PWM: Puls-Width Modulation

4

Abbildung 2: Peripherie [9]
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3.2 Headerboard HILEVEL Tester

Für  das  Testen  des  Chips  (Hardware-in-the-Loop  -  HiL)  dient  das  Headerboard  als 
Verbindungsglied zwischen den HILEVEL Tester (HiL-Simulator) und der controlCARD (HiL) mit 
dem  Mikrocontroller  TMS320F28335.  Das  Testen  ist  der  nächste  logische  Schritt  nach  dem 
Realisieren der Toolchain, damit sichergestellt werden kann, dass der Code fehlerfrei ausgegeben 
wird.  Die  PINs  des  Headerboards  „GPIO-PIN“  der  controlCARD sind  jeweils  mit  den  in  der 
Tabelle 1 aufgeführten PINs des HILEVEL Tester verbunden. 

Die  Analogen  Eingänge  des  TMS320F2833 sind separat  hinausgeführt  und  können an Lötösen 
abgegriffen  werden,  da  der  verwendete  HILEVEL Tester  zum aktuellen  Stand  keine  analogen 
Eingänge verarbeiten/simulieren kann. Parallel dazu wurden die AGND4 Pins angeordnet.

4 AGND: Analog Ground

5

 Headerboard Bottom  Headerboard Top

Belegung Headerboard Belegung HILEVEL Tester Belegung Headerboard Belegung HILEVEL Tester

GPIO-59 30 GPIO-06 3

GPIO-63 31 GPIO-04 6

GPIO-61 32 GPIO-01 9

GPIO-84 49 GPIO-05 12

GPIO-26 51 GPIO-21 33

GPIO-86 52 GPIO-25 34

- 54 GPIO-85 35

GPIO-12 55 GPIO-29 36

GPIO-18 57 GPIO-17 37

GPIO-15 58 GPIO-13 38

GPIO-22 60 GPIO-33 39

GPIO-24 61 GPIO-31 42

GPIO-28 63 GPIO-23 45

GPIO-48 83 GPIO-19 48

SCK 86 GPIO-03 71

GPIO-62 89 GPIO-00 74

GPIO-60 92 GPIO-02 77

GPIO-58 95 GPIO-08 80

GPIO-32 114 GPIO-27 99

GPIO-34 117 GPIO-14 102

GPIO-30 120 GPIO-49 105

GPIO-87 123 SDA 108

GPIO-20 126 GPIO-09 111

GPIO-16 128 GPIO-07 112
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In der Abbildung 5 ist das gesamte Headerboard zu sehen (Rückseite).

Der erstellte Schaltplan und das Layout sind im Anhang A zu finden. 

6

Abbildung 3: Headerboard Detailansicht

Abbildung 4: Headerboard Gesamtansicht (Rückseite)
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3.3 Praktikumsversuch Nachlaufregelung

Der Praktikumsversuch Nachlaufregelung besteht aus einer Linearachse mit der eine gewünschte 
Position angefahren werden kann. Der Aufbau der Linearachse ist in der Abbildung 6 zu sehen.

Die eingezeichneten Markierung stellen Folgendes dar:
1 Schiebepotentiometer (Positionsbestimmung, Streckeneingang)
2 Schlitten
3 Gleichstrommotor (über Leistungsverstärker, Streckenausgang)
4 Schwungmasse

In Abbildung 7 ist die Linearachse in einem Blockschaltbild dargestellt.

7

Abbildung 5: Linearachse

Abbildung 6: Blockschaltbild Linearachse [10]



Kapitel 3 – Verwendete Hardware

Funktion der Linearachse:
Beim Anlegen einer Spannung am Gleichstrommotor dreht sich die Spindel und der Schlitten wird 
je nach Drehrichtung nach links oder rechts bewegt. Der am Schlitten befestigte Schieberegler des 
Schiebepotentiometers  wird  dabei  mitbewegt.  Somit  erfährt  die  am  Schiebepotentiometer 
gemessene  Spannung  eine  proportionale  Wertänderung.  Durch  diesen  Vorgang  wird  eine 
Positionsbestimmung ermöglicht. Die Linearachse hat die Spannung für den Gleichstrommotor als 
einen Eingang und liefert mit dem Schiebepotentiometer eine Spannung.

Nachlaufregelung:
Der Regler hat die eingestellte Spannung am Drehpotentiometer des TI C2000 Peripheral Explorer 
Kit Boards und die gemessene Spannung am Schiebepotentiometer der Linearachse als Eingang. 
Mit dem Potentiometer des Boards wird die Sollwertvorgabe durchgeführt.

Potentiometer Drehung nach Links → Schlitten fährt nach Links
Potentiometer Drehung nach Rechts → Schlitten fährt nach Rechts

Es kann jede beliebige Position zwischen den Endwerten angefahren werden.

Als Ausgang muss der auf dem Delfino DSP5 implementierte Regler einen analogen Wert für den 
Gleichstrom bereitstellen. Da die verwendete controlCARD keinen analogen Ausgang hat, wird ein 
ePWM6 Signal  erzeugt.  Die  controlCARD  mit  dem  Delfino  TMS320F28335  kann  für  die 
verwendeten PIN nur Spannungen im Bereich von 0-3V verarbeiten (siehe [9] Seite 3 und [11] Seite 
77). Aufgrund dessen wurde eine Schaltung entworfen, die den Wertebereich anpasst.

Vorverschaltung:
Die  Schaltung  in  der  Abbildung  8  erzeugt  aus  dem  Wertebereich  (-15V  bis  +15V)  des 
Schiebepotentiometers  einen  für  den  analogen  Eingang [11]  am Peripheral  Explorer  Kit  Board 
gültigen Wertebereich (0 bis 3V). 
Der  erste  am  Schiebepotentiometer  angeschlossene  invertierende  Operationsverstärker  hat  eine 
Verstärkung von etwa -1/7 was den Wertebereich auf ungefähr -2V bis 2V verkleinert. Der daran 
anknüpfende invertierende Operationsverstärker ist ein Addierer. Dabei bestimmt U1 um wie viel 
der Bereich verschoben werden soll. Es wurde ein Wert von -2V für U1 eingestellt. Damit ergibt 
sich ein Wertebereich von 0 bis 4V. Da der Sollwert über das Drehpotentiometer am Board nur im 
Bereich zwischen 0 und 3,3V eingestellt werden kann, wird vom Schiebepotentiometer auch nur ein 
Wert in diesem Bereich erwartet.  

5 DSP: Digital Signal Processor
6 ePWM: Enhanced Pulse-Width Modulation

8
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Die Schaltung in der Abbildung 9 macht aus dem Wertebereich (0 bis 3,3V) des ausgegebenen 
ePWM-Signal ein für die Ansteuerung des Motors benötigten Wertebereich (-10V bis 10V).
An den  ePWM PIN des  Boards  ist  ein  invertierender  Operationsverstärker  angeschlossen.  Mit 
diesem  Addierer  wird  durch  U2 bestimmt,  wie  der  Eingangswert  verschoben  wird.  Da  das 
ausgegebene ePWM-Signal nur zwischen 0 und 3,3V liegt, wird bei der Wahl von U2 = -1,65V ein 
symmetrischer Wertebereich von -1,65V bis +1,65V erzeugt. Durch den folgenden invertierenden 
Operationsverstärker mit einer Verstärkung von etwa 6, wird der Wertebereich auf -10V bis 10V 
erweitert. Mit dem vor dem Motor geschalteten Leistungsverstärker ist die Schaltung komplett.

9

Abbildung 7: Schaltplan Teil 1

Abbildung 8: Schaltplan Teil 2
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4. Verwendete Software und Realisierung der Toolchain

4.1. Software

4.1.1. MATLAB

MATLAB, nach [3] und [12] ist ein Programm und eine Hochsprache. Damit können Berechnungen 
durchgeführt und anschließend visuell dargestellt werden. Die Software ist ein beliebtes Tool in der 
Industrie  sowie  an  Hochschulen  und  wird  unter  anderem  für  regelungstechnische  Aufgaben 
eingesetzt. Die grafische Oberfläche ist in der Abbildung 10 gezeigt.

Die eingezeichneten Markierungen stellen folgendes dar:
1 Command Window
2 Current Folder und Command History
3 Workspace

Im  Command  Window  werden  alle  MATLAB  Befehle  eingegeben  und  alle  Berechnungen, 
Warnungen sowie Informationen ausgegeben. Der Current Folder zeigt das aktuelle Verzeichnis an 
und hier können weitere MATLAB Modelle geladen werden. Die Command History listet alle im 
Workspace  eingegebenen  Befehle  auf.  Im  Workspace  werden  alle  in  der  aktuellen  MATLAB-
Sitzung vorhandenen Variablen mit den entsprechenden Werten hinterlegt.
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Abbildung 10: MATLAB Oberfläche
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Nach eingeben des MATLAB Befehls  ver im Command Window, wird die aktuelle MATLAB 
Version mit allen installierten Toolboxen angezeigt. Für die Durchführung dieser Anleitung wird 
Simulink sowie der Embedded Coder benötigt.

Durch das  Eingeben  des  Befehls  ver soll  überprüft  werden,  ob  die  für  die  Durchführung der 
Anleitung benötigten Toolboxen (Abbildung 11) installiert sind.

MATLAB Version 7.14
Simulink Version 7.9
Embedded Coder Version 6.2
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Abbildung 11: MATLAB und Toolboxen Version
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4.1.2. Simulink

Mit Simulink, nach [3] und [13] kann das modellbasierte Design und verschiedene Simulationen 
durchgeführt werden. Da hier mit Modellen (grafische Programmiersprache) gearbeitet wird und 
nicht mit Befehlen, erlaubt Simulink einen einfachen Überblick über den Sachverhalt. Die Simulink 
Library kann aus MATLAB wie in der Abbildung 12 zu sehen, aufgerufen werden.

Die  daraufhin erscheinende Simulink Library (Abbildung 13) erlaubt  das  Erstellen eines  neuen 
Modells über File > New > Model. In dem sich geöffneten noch leeren Modellfenster werden die 
benötigten Blöcke aus der Simulink Library eingefügt.
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Abbildung 13: Simulink Library Browser

Abbildung 12: Simulink Aufruf in MATLAB
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4.1.3. Embedded Coder

Eine während dieser Arbeit verwendete Toolbox in MATLAB ist der Embedded Coder [14]. Damit 
kann Code für verschiedene DSPs erzeugt werden. Im Simulink Library Browser befindet sich eine 
Kategorie „Embedded Coder“ in der  für  die jeweilige Zielhardware bestimmte Blöcke abgelegt 
sind. 

Für  das  verwendete  TI  C2000  Peripheral  Explorer  Kit  mit  der  controlCARD  und  dem 
TMS320F28335  DSP finden  sich  die  Blöcke  unter  Embedded  Coder  >  Embedded  Targets  > 

Processors > Texas Instruments C2000 > C28x3x (Abbildung 14).
Der Target Preference Baustein, der bei Simulink Modellen für Embedded Systeme vorhanden sein 
muss, findet sich unter  Embedded Coder > Embedded Targets > Target Preferences  (Abbildung 
31).
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Abbildung 14: Embedded Coder in der Simulink Library
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4.1.4. Code Composer Studio v5

Die von  Texas  Instruments  im Rahmen  vieler  Anwendungen kostenlos  zur  Verfügung gestellte 
Entwicklungsumgebung CCS [15]  basiert  auf  einer  ehemals  für  Java  entwickelten  quelloffenen 
integrierten  Entwicklungsumgebung.  Durch  die  vielen  Erweiterungen  ist  es  aber  mittlerweile 
möglich für nahezu alle Programmiersprachen zu entwickeln. Mit CCS kann nicht nur der C2000 
programmiert  werden  sondern  alle  von  TI  angebotenen  Mikrocontroller.  Die  grafische 
Benutzeroberfläche ist in der nachfolgenden Abbildung 15 gezeigt.

Die eingezeichneten Markierungen stellen folgendes dar:
1 Project Explorer (Überblick der angelegten Projekte)
2 Quellcode (Hier kann der Quellcode erstellt und editiert werden)
3 Target Configuration (Einstellungen der Zielhardware)
4 Console (Ausgabe zu einem Prozess ist hier einsehbar)

Die  Fenster  können  innerhalb  der  Entwicklungsumgebung  frei  konfiguriert  werden,  d.h. 
verschoben, geschlossen und über die Menüleiste unter View wieder geöffnet werden.
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Abbildung 15: CCS Oberfläche
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4.2. Konfiguration

4.2.1. MATLAB Konfiguration

Der folgende Abschnitt beschreibt die Konfiguration in MATLAB.

Im Command Window von MATLAB bitte folgenden Befehl eintippen: xmakefilesetup 
(Abbildung 16)

Daraufhin erscheint ein neues Fenster XMakefile User Configuration (Abbildung 17) in dem alle 
folgenden  Einstellungen vorgenommen werden.

15

Abbildung 16: Command Window Befehleingabe

Abbildung 17: XMakefile User Configuration
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Unter Template wird gmake ausgewählt und das Häckchen bei Display operational configurations  

only entfernen. Desweiteren sollte unter Configuration, ticcs_c2000_ccsv4(!) ausgewählt werden.
Dann einen Klick auf Apply, ohne das Fenster zu schließen.

Falls der Aufruf der XMakefile User Configuration zum ersten Mal erfolgt, so wird man nach dem 
Installationspfad für Code Composer Studio v4(!) gefragt. Es wird nach CCSv4 gefragt, da die 
neueste Version CCSv5 erst vor kurzem veröffentlicht wurde. Hier bitte den Installationspfad der 
verwendeten Version von Code Composer Studio angeben. Das sieht dann zum Beispiel so aus: 
C:\ti\ccsv5 bei der Verwendung von CCSv5.

Wenn der Aufruf schon bei der Konfiguration von CCSv4 erfolgte, dann sollen die Angaben für 
CCSv5 unter Tool Directories editiert werden.

Das sieht dann folgendermaßen aus (Abbildung 18):

CCS Installation: C:\ti\ccsv5\
Code Generation Tolls: C:\ti\ccsv5\tools\compiler\c2000_6.1.0\
DSP/BIOS Installation: C:\ti\bios_6_33_05_46\

Jetzt wieder ein Klick auf Apply ohne das Fenster zu schließen.
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Abbildung 18: XMakefile User Configuration: Tool Directories
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Der nächste Schritt wäre ein Klick auf New ganz rechts im XMakefile User Configuration Fenster. 
Es  wird  vorgeschlagen,  die  neue  Konfiguration  z.B.  ticcs_c2000_ccsv4_clone zu  nennen.  Ein 
Vorschlag wäre ticcs_c2000_ccsv5_based_on v4 (Abbildung 19) und anschließend auf OK klicken.

Alle Reiter in der XMakefile User Configuration sind jetzt editierbar und sollten insbesondere bei 
Compiler, Linker und Archiver auf das aktuelle Installationsverzeichnis von CCSv5 aktualisiert 
werden.

Das schaut dann z.B. wie in den Abbildungen 20 - 22:

Reiter Compiler:
Compiler: C:\ti\ccsv5\tools\compiler\c2000_6.1.0\bin\cl2000
Arguments: -I"C:\ti\ccsv5\tools\compiler\c2000_6.1.0\include" -fr"[|||
MW_XMK_DERIVED_PATH_REF|||]"

Reiter Linker:
Linker: C:\ti\ccsv5\tools\compiler\c2000_6.1.0\bin\cl2000

Reiter Archiver:
Archiver: C:\ti\ccsv5\tools\compiler\c2000_6.1.0\bin\ar2000

17

Abbildung 19: New 
Configuration Name
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A, Einstellungen unter Compiler

B, Einstellungen unter Linker

C, Einstellungen unter Archiver

Das  waren  jetzt  alle  Einstellungen  für  die  Erstellung  von  makefiles zur  Zusammenarbeit  von 
MATLAB/Simulink mit der Entwicklungsumgebung Code Composer Studio v5. Ein Klick auf OK 

und das Fenster kann geschlossen werden. Nun kann mit MATLAB/Simulink gearbeitet werden.
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Abbildung 20: Compiler

Abbildung 21: Linker

Abbildung 22: Archiver



Kapitel 4 – Verwendete Software und Realisierung der Toolchain

4.2.2. CCSv5 Konfiguration mit einem Beispielprogramm

Der folgende Abschnitt beschreibt die Konfiguration in der CCSv5 Entwicklungsumgebung. Falls 
CCSv5 zum ersten Mal gestartet wird, folgt eine Anfrage nach dem Anlegen eines Workpace. Eine 
mögliche Auswahl ist C:\Users\Benutzername\workspace_v5_2 (Abbildung 23).

Nachdem CCSv5 gestartet  und der Workspace angelegt wurde, wird das erste Projekt angelegt. 
Der Aufruf dazu geht über File > New > CCS Project (Abbildung 24).  
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Abbildung 23: Workspace

Abbildung 24: New CCS Project
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Für Project name kann z.B. MeinErstesProjekt gewählt werden. 
Das  Output  file sollte  ein  Executable sein  und  das  Häckchen  bei  Use  default  location gesetzt 
werden. 
In der Kategorie Device bitte unter Family die C2000 Family auswählen. Die verwendete Variante 

ist  der  TMS320F28335 und  die  Connection erfolgt  über  Texas  Instruments  XDS100v2  USB 

Emulator. Zur Target Configuration gelangt man später über View > Target Configuration und dann 
ein Doppelklick auf die *.ccxml-Datei im jeweiligen Projekt. Hier sollte später nochmals überprüft 
werden, ob die richtige Zielhardware eingestellt ist, bevor der Code übertragen wird.
Die  Auswahl  unter  Advanced  Settings und  Project  templates  and  examples kann  einfach 
übernommen werden.
Die Einstellungen werden durch einen Klick auf Finish übernommen und das Projekt erstellt.
In Abbildung 25 ist das angelegte Projekt zu sehen.

Als nächstes sollte die Größe des system stack für alle C Programme definiert werden [16]. Diese 
Einstellungen werden unter  Properties (Klick mit der rechten Maustaste auf MeinErstesProjekt) 
vorgenommen.  Unter  Build  > C2000 Linker  > Basic  Options >Set  C system stack  size:  0x400 

eingeben (Abbildung 26).
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Abbildung 26: System Stack

Abbildung 25: Angelegtes Projekt mit einer C-Code Vorlage von main.c
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Ein kleines Beispielprogramm wird nun in CCSv5 erstellt und anschließend auf dem Delfino DSP 
ausgeführt  um die  vorher  vorgenommenen  Einstellungen  zu  überprüfen,  d.h.  die  Funktion  der 
Zielhardware sicher zu stellen.

Das  vorher  angelegten  Projekt  findet  sich  im  Project  Explorer.  Hier  kann  eingesehen  werden, 
welche Dateien automatisch von CCS angelegt sind. Im Projekt wurde eine C-Code Datei (main.c) 
angelegt, die durch einen Doppelklick aufgerufen wird. Der C-Code soll, wie in der Abbildung 27 
zu sehen übernommen werden [16]. Damit ist ein erstes Programm erstellt.

Es ist ein sehr einfaches Programm mit zwei Variablen i und k. Das Programm besteht aus einer 
Endlos-Schleife ( while(1) ) in der ein for-Loop ausgeführt wird. Im for-Loop wird die Variable 
i von 0 bis 99 hochgezählt. Die Variable k ist dabei i * i.

Mit Project > Build Project wird der Code kompiliert und eine Ausgabedatei (*.out) erstellt. In der 
Console soll bei einem erfolgreichen Kompilieren ein Build Finished stehen.

Mit einem Klick auf Debug (Abbildung 28) werden gleich drei Schritte ausgeführt:
• Rebuild (Output-Datei erstellt)
• Connect Target (Verbindung zur Zielhardware hergestellt)
• Load Program (Programm geladen)
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Abbildung 27: C-Code

Abbildung 28: Debug
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Durch den Klick auf  Debug gelangt man in die  CCS Debug Perpective. Ein Indikator dafür, dass 
das Programm in diesem Fall richtig übersetzt und geladen wurde ist der blaue Pfeil, der auf die 
Zeile 8 (for-Loop) im Programm zeigt (Abbildung 29). Da erfolgt die erste Wertänderung. Mit View 

> Expressions wird ein Fenster Expressions aufgerufen in dem die Variablen i und k über Add nex  

expression angezeigt werden. Hier ist unter anderem der aktuellen Wert der Variablen aufgeführt.

Um die Wertänderung der Variablen nach jedem for-Loop Durchlauf beobachten zu können, werden 
Breakpoints gesetzt. So wird durch einen Doppelklick links neben der Zeile 10 (blauer Bereich) ein 
Breakpoint  gesetzt. Durch Anklicken von  Resume (alternativ F8-Taste) findet ein Durchlauf des 
Programms bis zum Breakpoint statt. Die damit einhergehende Wertänderung der Variablen ist unter 
Expressions (Abbildung 30) sichtbar.
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Abbildung 29: CCS Debug

Abbildung 30: Breakpoint
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4.3. Datenverarbeitung an einem Beispielmodel

Der  folgende Abschnitt  beschreibt  die  Code Erstellung (Code Generation)  aus einem einfachen 
Beispielmodell  in  Simulink  und  den Import  der  erzeugten  Datei  in  CCSv5 mit  anschließender 
Übertragung auf die Zielhardware. 

Nach dem Start von Simulink aus MATLAB sollte unter  File > New > Model ein neues Fenster 
geöffnet  werden.  Als  nächstes  wird  aus  der  Simulink  Library der  Baustein  Target  Preferences 

ausgewählt. Dieser findet sich unter Embedded Coder > Embedded Targets (Abbildung 31). 
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Abbildung 31: Baustein Target Preferences
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Hierbei  kann  der  Baustein  einfach  ins  vorher  neu  angelegte  Fenster  per  Drag&Drop  gezogen 
werden.  Sobald  der  Baustein  sich  im  Simulink  Modell  befindet,  sollten  seine  Einstellungen 
vorgenommen werden. 

Zu den Einstellungen des Bausteins  Target Preferences gelangt man bereits beim Einfügen in das 
Modell. Für spätere Änderungen kann man durch einen Doppelklick auf den Baustein, oder durch 
einen Rechtsklick mit anschließender Auswahl des Punktes Open Block die Einstellungen öffnen.

Unter IDE/Tool Chain sollte Texas Instruments Code Composer Studio v4 (makefile generation 
only)  (!)  ausgewählt  werden.  Die  Version  5  von  CCS  wurde  noch  nicht  in  die  Menüführung 
einbezogen, aber die Einstellungen gelten auch für diese Version. 
Nach einem Klick auf den Reiter  Board sollte  dort  unter  Board:  C2000 Custom,  der  Processor 
F28335 und CPU Clock 150 ausgewählt werden.
Ein Klick auf Apply und OK beendet die Einstellungen (Abbildung 32).
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Abbildung 32: Target Preferences
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Zur  schnellen Veranschaulichung der  Code Erstellung wird das  in  der  folgenden Abbildung 33 
verwendete einfache Modell einer blinkenden LED erstellt. Dazu wird aus der Simulink Library 
der Baustein Constant unter  Simulink > Commonly Used Blocks und den Digital Output Baustein 
unter  Embedded Coder >  Embedded Targets >  Processors >  Texas Instruments C2000 >  C28x3x 

ausgewählt.  Die  Bausteine  können  einfach  aus  der  Simulink  Library per  Drag&Drop  in  das 
Modellfenster gezogen werden. Um eine Verbindung zwischen den zwei Bautsteinen herzustellen, 
muss der erste Baustein angeklickt und anschließend bei gedrückter Strg-Taste der zweite Baustein 
angeklickt werden. Daraufhin sind die zwei Bausteine durch  einen Pfeil verbunden.

Die Bausteine  Constant und  Digital Output sollen noch vor dem Build des Modells konfiguriert
werden.  Dies  kann  durch  einen  Doppelklick  auf  den  Baustein  vorgenommen  werden.  Beim 
Constant Baustein  eine  1 unter  Constant  Value eingetragen.  Beim  Digital  Output im sich  neu 
geöffneten Fenster (Abbildung 34) die GPIO Group: GPIO8~GPIO15 auswählen und ein Häkchen 
bei GPIO9 (LED1 liegt an diesem PIN) und Toggle GPIO9 setzen. Ein Klick auf OK beendet die 
Konfiguration.
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Abbildung 33: Simulink Modell

Abbildung 34: Digital Output
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Sobald die Bausteine konfiguriert sind, kann aus dem Modell der Code erstellt werden. Dies erfolgt 
durch die Tastenkombination Strg + B oder durch einen Klick auf Tools > Code Generation > Build  

Model. Der Build-Prozess kann im MATLAB Command Window beobachtet werden. Nach einem 
erfolgreichen Build steht im Command Window von MATLAB ein Built done und Download 
done. Der komplette Build findet sich im MATLAB Workspace in einem neuen Ordner mit dem 
Namen Modellname_ticcs. Hier befindet sich die später verwendete *.out-Datei. In dieser Output-
Datei ist die gesamte Ausgabe aus der Code Erstellung zusammengefasst. Das ist die Datei, die in 
CCS  importiert  wird.  Des  Weiteren  kann  der  generierte  C-Code  (mehrere  Dateien)  separat 
eingesehen werden.

Das  war  die  Code  Erstellung in  Simulink.  Daran  anknüpfend  erfolgt  der  Import  des  Codes  in 
CCSv5.

Für die Durchführung des Imports der Datei  ist  es erforderlich,  dass die Zielhardware über  ein 
USB-Kabel mit dem PC verbunden und eingeschaltet ist (Hauptschalter am Peripheral Explorer Kit 
Board). 
Im CCSv5 wied unter View > Target Configurations das Fenster Target Configurations aufgerufen. 
In  diesem  Fenster  befindet  sich  bei  einem  angelegten  Projekt  (z.B.  MeinErstesProjekt)  eine 
*.ccxml-Datei.  Eine  *.ccxml-Datei  enthält  die  komplette  Target  Configuration.  Durch  einen 
Rechtsklick  darauf  und  anschließend  ein  Klick  auf  Launch  Selected  Configuration wird  die 
ausgewählte Konfiguration gestartet (Abbildung 35). 
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Abbildung 35: Launch Selected Configuration
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Im sich neu geöffneten Fenster (Debug) befindet sich die vorhin ausgewählte *.ccxml-Datei. Nach 
einem Rechtsklick darauf,  Connect Target auswählen (Abbildung 36). Die Verbindung ist nun mit 
der Zielhardware hergestellt.

In der Menuleiste unter  Run > Load > Load Program >Browse (Abbildung 36) die *.out-Datei 
auswählen. Diese befindet sich im MATLAB Workspace. Nach dem Auswählen und einem Klick 
auf Öffnen wird die *.out-Datei in CCSv5 geladen.
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Abbildung 36: Connect Target

Abbildung 37: OUT-Datei Auswahl
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Nach  dem Drücken  der  Taste  F8  oder  dem Anklicken  des  Resume Buttons  (Abbildung 38)  in 
CCSv5 läuft das Programm einer blinken LED auf dem Peripheral Explorer Kit. 
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Abbildung 38: Resume
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5. Demonstration der Toolchain

Für  eine  Beurteilung  des  modellbasierten  Softwareentwurfs  soll  demonstriert  werden,  dass  die 
vorgenommene Konfiguration in MATLAB und der Einsatz der damit erzeugten Output-Datei in 
CCSv5 auch zu einer Implementierung von Regler auf DSPs möglich ist. 
Dazu  wurde  ein  Versuch  aus  dem  Regelungstechnik  Labor  der  Hochschule  Rosenheim  im 
Studiengang Produktionstechnik, wie in Kapitel 3.3 beschrieben verwendet.

Die Demonstration in diesem Kapitel beginnt mit der Erstellung eines Simulink-Modells für den 
Praktikumsversuch Nachlaufregelung, gefolgt von der Code Erstellung aus dem Simulink-Modell, 
einem anschließenden Import der Output-Datei in CCSv5 sowie einer Übertragung auf den Delfino 
DSP auf der controlCARD.

Nach dem Start  von MATLAB und dem Aufruf der Simulink Library (Abbildung 12) wird ein 
neues Modellfenster aufgerufen (Abbildung 39). 

Darin  ist  als  erstes  der  Target  Preference Baustein  (Abbildung  31)  eingefügt  worden.  Dieser 
Baustein  ist  für  jede  Code  Erstellung  aus  einem  Simulink-Modell  für  eingebettete  Systeme 
notwendig. Nach dem Drag&Drop aus der Simulink Library in das Modellfenster wird automatisch 
nach den Konfigurations-Parameter (Abbildung 40) gefragt.
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Abbildung 39: Neues Modell

Abbildung 40: Konfigurations-Parameter
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Der Abbildung 40 entsprechend sind folgende Einstellungen vorgenommen:

• IDE/Tool Chain: Texas Instruments Code Composer Studio v4 (makefile generation only)
• Board: C2000 Custom
• Processor: F28335

Für den Praktikumsversuch Nachregelung wird ein P-Regler verwendet. Die Verstärkung wurde mit 
dem Faktor 10 festgelegt. Der Regler hat einen mit dem Drehpotentiometer festlegbaren SOLL-
Wert als Eingang und die Rückführung der Regelstrecke, also die IST-Wert Erfassung über das 
Schiebepotentiometer. Als Ausgang wird ein ePWM-Signal für den Motor bereitgestellt.
Die verschiedenen Bausteine des erstellten Simulink-Modells (Abbildung 41) werden anschließend 
im Einzelnen aufgeführt und deren Konfiguration detailliert beschrieben. Die Device-spezifischen 
Bausteine (ADC und ePWM) befinden sich wie in Kapitel 4.1.3 erklärt in der Simulink Library 
unter Embedded Coder > Embedded Targets > Processors > Texas Instruments C2000 > C28x3x 

(Abbildung 14). Alle anderen sind aus Simulink > Commonly Used Blocks (Abbildung 13). 
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Abbildung 41: Simulink-Modell
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Der SOLL-Wert wird mit dem Drehpotentiometer bestimmt, welches beim Peripheral Explorer Kit 
am analogen Eingang A1 liegt. Der gelieferte Wert ist vom Typ unit16. Die Einstellungen für den 
Baustein ADC sind in Abbildung 42 und 43 zu sehen getroffen worden.

Der IST-Wert wird mit dem Schiebepotentiometer bestimmt, welches beim Peripheral Explorer Kit 
am analogen Eingang B2 angelegt wurde. Der gelieferte Wert ist vom Typ unit16. Die Einstellungen 
für den Baustein ADC sind in Abbildung 44 und 45 zu sehen.
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Abbildung 42: SOLL-Wert ADC Control Abbildung 43: SOLL-Wert Input Channels

Abbildung 44: IST-Wert ADC Control Abbildung 45: IST-Wert Input Channels
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Die Konfiguration des ePWM Blocks erfolgt unter dem Reiter  General. Die Timer period ist auf 
4095 festgelegt. Das ist erforderlich, da der Drehpotentiometer eine 12-Bit Auflösung aufweist und 
infolgedessen eine PWM nur im Bereich zwischen 0 und 4095 realisierbar ist.

Um vom P-Regler den gelieferten Wert in ein PWM-Signal umzuwandeln, wird unter dem Reiter 
ePWMA die Input port Einstellung getroffen sowie der Anfangswert auf 0 gesetzt.

Die Subsysteme im Simulink-Modell (Abbildung 41) dienen der Umrechnung der von den Device-
spezifischen Blöcken gelieferten Werte. Sie sind das „Software-Pendant“ zu den OPV-Schaltungen, 
die  zwischen  dem  Peripheral  Explorer  Kit  und  den  Ein-  bzw.  Ausgang  an  der  Linearachse 
verschaltet sind (Kapitel 3.3). Damit wird im Modell so gerechnet, wie der P-Regler ausgelegt ist.
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Abbildung 47: ePWMA

Abbildung 46: ePWM General
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Abbildung 48: Subsystem 1

Abbildung 50: Subsystem 3

Die  Bereichsanpassung  aus  dem  ersten 
Subsystem  führt  aus  dem  Eingangswert 
der  OPV  zum  Drehpotentiometer.  Der 
Eingangswert  der  zwischen  0  und  3V 
liegt,  wird  in  einen  Ausgangswert 
zwischen -10V und 10V überführt. 

Im  zweiten  Subsystem  wird  aus  der 
Ausgabe  des  P-Reglers  eine  Bereichs-
anpassung für den Ausgang auf 0 bis 3V 
vorgenommen.  Dabei  wird  zuerst  der 
Bereich von -10V bis 10V auf 0 bis 20V 
verschoben  und  dann  über  den  Faktor 
3/20 auf 0 bis 3V angepasst. Dies liefert 
den Eingang für den ePWM Block. 

Abbildung 49: Subsystem 2

Das dritte Subsystem wandelt  wiederum 
aus  dem  Eingangswert  der  OPV  nach 
dem  Schiebepotentiometer  (0  bis  3V), 
einen für den Regler benötigten Bereich 
zwischen -15 und 15V durch.
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Das Simulink-Modell für die Nachregelung ist erstellt und alle Parameter eingegeben. Dem folgend 
kommt die Code Erstellung. Dies wird ebenfalls in Simulink ausgeführt. 

Dazu  wird  in  der  Menüleiste  unter  Tools  >  Code  Generation  >  Build  Model (Abbildung  51) 
ausgewählt und der gesamte Build kann im Command Window von MATLAB verfolgt werden. Am 
Ende dieser Prozedur steht im Command Window ein Build done und Download done. 
Im Workspace von MATLAB findet sich umgehend im Projektordner eine Output-Datei, die im 
nächsten Schritt Verwendung findet.

Nach dem Start von CCSv5, dem Verbinden und Einschalten des Peripheral Explorer Kit über das 
USB-Kabel  mit  dem  PC  wird  die  aktuelle  Zielhardware-Konfiguration  ausgewählt  (Launch 
Selected Configuration) und somit eine Verbindung hergestellt (Connect Target), wie in Kapitel 4.3 
Abbildung 35 und 36. 
Der Import der *.out-Datei erfolgt über die Menüleiste (Run > Load > Load Program). Nach der 
erfolgreichen Ausführung auf dem Peripheral Explorer Kit, kann mit dem Drehpotentiometer 1 die 
Sollwertvorgabe  durchgeführt  werden  und  der  Schlitten  wird  vom  Regler  in  die  gewünschte 
Richtung nachgeführt.
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Abbildung 51: Build Model
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A. Anhang Headerboard (Schaltplan + Layout)

Die für Hardware-in-the-Loop am HILEVEL-Tester benötigte Verbindung zwischen dem Tester und 
der controlCARD wurde im Rahmen der Bachelorarbeit „Studie zur Toolchain des modellbasierten 
Softwareentwurfs und Test eines C2000 Mikrocontroller mit MATLAB/Simulink“ entworfen. Der 
Schaltplan und das Layout (Vorder- und Rückseite) der Platine befinden sich im Anhang.
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B. Anhang Praktikumsanleitung

Im Rahmen der Bachelorarbeit „Studie zur Toolchain des modellbasierten Softwareentwurfs und 
Test eines C2000 Mikrocontroller mit MATLAB/Simulink“ wurde eine Anleitung für das 
Regelungstechnik Labor der Hochschule Rosenheim erstellt.
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